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Media & Entertainment (M&E) industry is in a transformation phase
as both old and new continues to coexist. Interactivity, digitization,
multiple-platforms, multiple-devices and globalization of services
based landscape has remodeled the media and entertainment vertical
over the last decade.

Social Media, Mobility, Analytics and Cloud Computing (SMAC), the
new generation in technology & globalization is now the next wave
catalyst of change for the industry.

The Media and Entertainment (M&E) industry has multiple segments that combine into one vertical;
Movies/Cinema, Television, Music, Publishing, Radio, Internet, Advertising and Gaming. Moreover,
trends and drivers for each of the segments vary across sub-segments, geographies and consumer
segments. This makes the vertical unique, since these sub-verticals compete, compliment and combine
to fulfil the ever-increasing demand for entertainment and information globally.

The industry also depends on multiple external factors/technology developments like wireless, mobile,
devices, digitization, internet access speeds, cloud storage, consumer analytics and social media among
others. The industry has successfully adapted around these developments in every generation. Since
1990s, digitization of content has changed creation and delivery of music. Another disruption in 2000s,
the rise of the internet was a game changer for all the sub-verticals of the industry. Presently, social
media has been instrumental in shaping the present media & entertainment industry.

Traditionally the M&E industry has been a creative industry following technology innovations and
consumer demands. By its inherent nature, the industry is extremely dependent on markets, cultures,
languages and consumer segments. We have, however, witnessed content that have bridged not only
the language barrier, but also worked across segments internationally. M&E is also unique due to its
psychological, emotional and aspirational appeal to its customers. Quality and acceptance hence
become extremely subjective to each individual. Traditionally, content creators were the deciders on
what to supply — the critical change in the new era is that de-
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mand is completely consumer driven. The new age consumer M&E: Digitization by 2018

not only demands what they like, but also in the format they = Digital - = Non-Digital
like, additionally, they also want to customize the content to
their preferences.

Transformation to Digital

M&E organizations of the new generation are striving for oper-
ational excellence and benchmarking themselves with the best-
in-class organizations in other sectors. From the way, budgets
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are determined, to how the research, content creation and distribution are conducted is now stream-
lined and performed professionally with proper project management. One of the significant changes in
the content has been its digitization. The digital innovation, which
resulted in converting analog video/audio into digital format, transformed the way content is
distributed and consumed. The transformation to digital is still underway and it is still common to find a
combination of old and new used together in the industry.

Avasant’s observations and analysis suggest that consumer demand for M&E is primarily driven by
interactivity and connectivity. This trend is expected to grow and become the primary channel for
meeting the increasing demand by M&E organizations in the next five years.

Consolidation and Standardization

Multiple device and platform environment is expected to move towards standardization of formats.
Large numbers of file extensions and formats have already become redundant, while the new formats
for 3D and HD in video and stream-able/compressed format for audio have taken over. With over 170
digital video formats and 130 audio digital formats, standardization of formats is not only expected but
also a necessity for the future.

Due to interactive and interlacing digital content, the gaps between various segments like television,
gaming, radio, internet, advertising etc. have diminished. This increasing integration of content across
segments is leading to consolidation of production houses and vendor markets. Large M&A contracts
like Facebook-WhatsApp, Microsoft-Skype, Walt Disney-Pixar, MySpace-News Corp, Google-YouTube,
McClatchy-Knight Ridder, etc. is continuing to shape the industry.

Social Media

Impact of social media on lifestyle has manifested in the way we consume media and entertainment.
From the way we are influenced about news, collaborate over a game or share information — social
media has resulted in a complete paradigm shift for M&E. Speed of information dissemination has
increased tenfold as a result of social media and it is not just a one-way street anymore — there is
complete interactivity resulting in immediate feedback, comments and analysis. Avasant anticipates
customized M&E content in the future as a result of social media and the information we choose to
share.

Analytics, Animation and Interactivity

Content developers are more and more depending on animation and visual effects in their production.
The development of content in these technology domains have a high rate of penetration by specialized
vendors to outsource. Niche service providers have developed significant credibility and the spend from
the industry has also drawn some large outsourcing vendors to provide M&E outsourcing services.

New analytical models enable focused customer experience for the target audience. Big data and
advanced statistical techniques have transformed the way content is now distributed and demand
analyzed.

Page 3 of 17
© Avasant, LLC & its affiliates



>

AVA S A N T Media & Entertainment: An Overveiw

Resource and Experience

One more factor that makes the M&E industry unique is the people who create content. Average
experience of creative professionals is over 20 years; this also creates a constant talent requirement for
the industry. Because of the cost pressures and limited talent pool, the industry has taken strategic
decisions which manufacturing took in the 70s, information technology took in the 80s and Engineering
Services has taken in the late 90s — to outsource/offshore.

Offshoring to Optimize

Offshoring provides not only improved bottom lines and improved operational efficiency, but also more
importantly, access to previously untapped experienced resource pools. It is common to find animation,
effects, editing and audio/video synchronization performed by offshore resources or by niche service
providers in countries like India, China, Philippines, Malaysia, Korea and Taipei.

Experienced talent for M&E is difficult to find and scalability has always been a challenge for the indus-
try. Sourcing and globalization have enabled the industry to not just reduce cost, but also harness the
talent available globally. The top services, offshored by production houses to vendors or performed in
captives outside are:

Ideation and Creative Process
Scriptwriting, Storyboarding & Copyrighting
Creative Graphics & Designing
Animation & 3D Modeling

Visual Effects (VFX)

Typesetting and Documentation
Editing, Dubbing and other Processing
Content/Format Transformation

. Content Research

10. Anti-Piracy Measures

11. Digital Asset Management
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While the M&E industry was facing sustainability issues and negative growth during the Global Economic
Slowdown, the outsourcing of processes witnessed steady performance. Larger contracts have been
signed since 2010 that have helped the recovery and growth of outsourcing in M&E. Direct relations for
the industry to the economic stability and consumers’ disposable can result in volatility in the regional
markets — which cumulates into a global impact.

Buyers of outsourcing, including the top Forbes companies like Comcast, Walt Disney, Time Warner,
DirectTV, Thompson Reuters, CBS, Viacom, British Sky among others have been steady outsources. The
participation rate, though, of buyers from M&E has been behind most other prominent verticals.
However, for a vertical that is primarily content-based and requires specialized services, the 30% to 40%
participation of M&E buyers of outsourcing is significant.

(6e] 9] E14)Y Country Headquarters ITO BPO

Industry Specific
Outsourcing Outsourcing Domain
Outsourcing

Comcast United States Yes No Yes
América Movil Mexico Yes Yes Yes
News Corp United States Yes Yes Yes
Time Warner United States Yes Yes Yes
Telstra Australia Yes No Yes
Directv United States Yes Yes No
Thomson Reuters Canada Yes Yes Yes
CBS United States Yes No Yes
Viacom United States Yes No No
Reed Elsevier United Kingdom Yes No No
Sony Japan Yes Yes Yes
Omnicom Group United States Yes Yes Yes
Vivendi France Yes Yes Yes
Liberty Global United States No Yes No
British Sky Broadcast- United Kingdom Yes No No
ing
Pearson United Kingdom Yes No Yes

For the top M&E organizations, IT outsourcing is quite common and most have contracts with one of the
traditional outsourcing service providers. BPO is a mix, with a few organizations outsourcing services like
F&A, HRO and Procurement while others have preferred to keep their services in-house. Specialized
services for creative, processing, release and post-release functions are often outsourced to niche
service providers.

The vendor landscape for M&E includes a large number of niche players like Greater China Media &
Entertainment, Procon, Plum Digital Media, Toonz Animation, NGEN, Sourcel8, Holy Cow Animation,
Pentamedia Graphics, Crest Animation Studios and DQ Entertainment. On the other hand traditional
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outsourcing vendors have also developed specialized services for the M&E vertical; the prominent ones
include Capgemini, Accenture, TCS, Tech Mahindra, Patni Computers, Atos, RR Donnelly and IBM.

Media & Entertainment Market and Segments

Avasant estimates the revenue from all M&E channels to be USS$1.6 trillion in 2013. The market is
expected to maintain steady growth of over 6% YoY over the next 5 years. M&E industry directly reflects
the state of the global economy and disposable income that the consumers have to spend on
entertainment. After the Economic Slowdown, the industry has successfully recovered since 2011 with
8% growth.

Media & Entertainment Industry

s
{g;,‘ Internet

@ Advertising
(]

1
> The Walt Disney Corp. > Electronic Arts
> Time Warner Inc. > Universal Studios
> Sony Corporation > Virgin Group
> Viacom > Verizon Communications Inc.
> Fox Entertainment Group > Hallmark Cards Inc.
> Yahoo! Inc. > McGraw Hill Company
> Google Inc. > ESPN Inc.
> Apple Inc. > Reuters )
Offshore Destinations
* Poland H
j_\gliliga'Kpre_a
India Taipei
L ‘ The Philippines
"B‘razil Malaysia
p
> Greater China Media & Entertainment > Crest Animation Studios
> Procon > DQ Entertainment
> Plum Digital Media > Capgemini
> Toonz Animation > |IBM
> NGEN > Accenture
> Sourcel8 > Patni Computers
> Holy Cow Animation > Tech Mahindra
> Pentamedia Graphics > Infosys BPO
\

The M&E vertical is split into eight sub-segments based on the type of content and distribution:

Vertical/Content Based M&E
1. Movies/Cinema

Television

Music

Publishing

PwnN
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5. Radio
6. Gaming

Horizontal/Channel based M&E
7. Internet
8. Advertising

M&E Industry: Market and Segments

2013 Revenue  — Growth in next 5 years
10.9%
—
6.7% 6.6%
— —
. 3.9%
3.3% 2.9%
— 2.4% 2.2%
I
—
I —
US$85B US5165B USS55B US$330B US$45B USS65B US$400B US$475B
Movies/Cinema  Televisioin Music Publishing Radio Gaming Internet Advertising
s ™

Emerging markets in Asia Pacific . .
Eing ! ' " MG&E Industry: Fastest growing countries

and Latin America have enabled the (CAGR: 2013-18)

M&E industry to sustain revenues B

though the Global Economy China  [11%
Slowdown. The industry due to its Brazil |10%
direct relationship with disposable India [Ji6%
income of its customers took a Russia | 9%
major drop during the Slowdown. Mexico i 1%
The 2007 revenue of USS$1.6 trillion e

is however back in 2013 and the Indonesiz i 15%
future of the industry looks Argentina  [[11%

A S

promising. Countries like India and
Indonesia have large markets with high growth and potential, these new markets provide new sales
opportunities for M&E content for production houses.
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1. Movies/Cinema

Films/Movies have been one of the key entertainment channels across the world and expected to
continue on its growth trajectory for the next 5 years at about 3%. Digitization of content has not only
created several opportunities for the sub-segment, but also numerous new challenges. Content sold for
one platform is now readily transferable to another without additional sales, however the challenge of

piracy has increased manifold due to ease of distribution.

Processing — Release - Post Release
@ “ud
{ @ | = | | \--'; | 1 Em |

> Research > Shooting > Distribution > Post-Release
> ldea Generation > Editing > Test Release Marketing
> Synopsis > Content > Local Premiere > Publicity
> Treatment Transformation > Global Premiere > Advertising
> Screenplay > Digital > Music Release > PublicRelations
> Casting Transformation > Audio CDs > Sales Promotions
> Music/OST > Format > New Format > Personal Selling
Compilation Transformation > Mp3, wav > Direct Marketing
> Feasibility > Promotional Content > Real & Flash > PostRelease
> Technical > Shooting Format activities are
> Operation > Poster/Billboard > New Platform maximum for Cinema
> Financial Creation > iTunes > Collections
> Finalizing > Animation/Special > Jukebox > Ratings
Effects > Xbox360 > Anti-Piracy Measures
> Music/OST > PlayStation > Awards & Film
> Digital > DVD/Blu-Ray Release Festivals
Transformation
> Format
Transformation
> Content
Refining/Finalizing
> Content
Quality/Testing
> Audio-Music-Video
Integration &
Synchronization
Content Distribution/Marketing
Emerging markets in Asia Pacific like China, [ A

Thailand and India have had double-digit Movies/Cinema Revenue by Geography

(2013)
growth and have kept the momentum through
the Global Economic Slowdown. On the other Latin
. . . . . America
hand countries like Russia, Argentina, Brazil 5%
and Venezuela are expected to have around APAC North
5% growth in the coming five years. The larger 25% America
and traditional markets of the United States a0%
and Europe are expected to remain stagnant.
Box office collections of movies have
. . EMEA
traditionally been the single largest source of § 30% )

income for production houses. Avasant
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expects significant transition in revenue to the device based distribution in the next 3-5 years, exceeding
box office collections. Digital sales over platforms like Blu-ray, DVD, iTunes, YouTube etc. will become
prominent channels for the majority of movies across budgets.

2. Television

Television has been transformed after digitization, not only the way content was produced changed, but
also the devices have transformed drastically. Avasant believes that for the segment in presently moving
towards digitization, while we still see CRT televisions in the developing countries, internet television is
gaining popularity in the developed economies. We also continue to have terrestrial free-to-air delivery
of television content along with co-axial cable subscriptions while satellite TV has completely taken over
most major cities globally.

) =
Ed

> Research > Shooting > Telecast/Broadcast > Post-Release
> |dea Generation > Editing > Distribution Marketing
> Synopsis > Content > Cable Network > Advertising
> Treatment Transformation > Direct-2-Home > PublicRelations
> Screenplay > Digital > Satellite TV > Publicity
> (asting Transformation > Internet TV > Sales Promotions
> Music/OST > Format > Podcast > Direct Marketing
Compilation Transformation > Mobile TV > Personal Selling
> Feasibility > Animation/Special > Streaming > TRP Ratings
> Technical Effects Devices > Collections
> Operation > Music/OST > DVD/Blu-Ray Release > Awards
> Financial > Digital
> Finalizing Transformation
> Format
Transformation
> Content
Refining/Finalizing
> Content
Quality/Testing
> Audio-Music-Video
Integration &
Synchronization
Content Distribution/Marketing

The vertical is also constantly faced with challenges due to digitization and new delivery models such as
pay TV, internet TV (IPTV) and interactive TV in the developed economies. Developing economies have
the power of growth; countries like Indonesia, India, Vietham and Thailand are expected to have
double-digit growth in their television markets.
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3. Music

The music industry has been under tremendous stress due to multiple challenges post digitization,
however, growth is expected to return in the next 2-3 years. The overall market is around USS$55 billion
and expected to grow to over USS60 billion by 2018 at around 3% CAGR. Music is one of the segments
where Europe is larger in terms of revenue compared to North America due to the large markets of
United Kingdom, France and Germany.

Ed

> Research > Recording > Music Release > Post-Release
{minimal) > Content > Distribution Marketing
> ldea Generation Transformation > Audio CDs > Advertising
> Feasibility > Digital > New Format > PublicRelations
> Technical Transformation > Mp3, wav > Publicity
> Operational > Format > Real & Flash > Sales Promotions
> Financial Transformation Format > Direct Marketing
> Music Creation > Album Cover Design > New Platform > Collections
> Lyrics Creation > Music Video > iTunes > Anti-Piracy Measures
> Music Video Idea > Casting > Jukebox > Awards & Shows
Creation > Shooting > Xbox360
> Finalizing > Content > PlayStation
Transformation
> Animation/Special
Effects
> Audio-Music-Video
Integration &
Synchronization
Content Distribution/Marketing

The greatest threat the music industry faces post digitization is Piracy. Every aloum and track is available
on the internet almost at the same time it is released from some source or the other. The industry has
faced difficulty to regulate content from the device side as well since while iTunes sells most content,
content downloaded from pirated sources also work with the devices. Piracy will continue to be a
significant challenge in the next five years while revenues from live performances and concerts will
balance the revenue stream with over US$25 billion revenues in 2013.

BRIC nations are also expected to balance the revenue growth for the industry with high double-digit
growth figures. Music streaming and smartphones with the improved music capability are also
opportunities for the music industry to capitalize. Avasant expects digital music to overtake physical
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formats like audio CDs by 2018. Streaming of music on-demand will also become a significant
contributor to music revenues in the next five years.

4. Publishing

Publishing is further segmented into 1) Newspaper Publishing; 2) Magazine Publishing and 3) Book
Publishing. All the three segments have a separate market and the future outlook for each of them is
very different due to digitization of content and new technology. In 2013, the publishing segment
garnered USS$330 billion in revenues and Avasant predicts it to grow at around 2% year-on-year in the
next 5 years.

Processing Release - Post Release
N\ <
J . oo
== - -

> Research > Reviewing > Cross Media > Post-Release
(extensive) > Editing Composition Marketing
> Content > Copy Editing > Print Format > Advertising
Development > Detailed Editing > Digital Format > PublicRelations
> Data Entry/Capture > Consistency Check > HIML > Publicity
> Document > XML Conversion > PDF > Sales Promotions
Scanning /OCR > Proofing/Corrections > e-Book > Direct Marketing
> News Harvesting > Document > e-Magazine > Post-release activities
> Abstract Creation Proofreading > Audiobook are minimal for
> Finalizing > Book Interior Design > Flash Format Publishing
> Document > Distribution > Anti-Piracy Measures
Conversion > Daily > Book Reading Events
> Graphics > Weekly > Awards &
> Cover Design > Fortnightly Recognitions
> Image > Monthly
Optimization > Annual
> Conversion of digital
graphic files

> Data Manipulation

> Format Conversion
> HTML

PDF

e-Book

e-Magazine

Audiobook

VOV VW

Content Distribution/Marketing

Newspaper Publishing, despite the many challenges like e-Papers, new devices, news broadcasters etc.
has sustained growth. This can be attributed to the newspaper reading habit for most people and
developing economies where the literacy is still growing. Revenue for the sub-segment, however, have
been influenced severely by digitization, especially the advertisement revenue. Newspaper brands have
also become digital and advertisement revenue is a combination of not just print but also digital
distribution.
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The Global Magazine Publishing market is proving resilient, and while it has declined over the past few
years, publishers are now responding to changing consumer demands, especially around digital content.
US dominates the consumer magazine market with over 32% of global revenue share for 2013, however,
increasing digitization is expected to shrink the market in the next 3-5 years. Meager growth of about
1% is expected in the magazine publishing segment.

Book Publishing is one of the most robust segments for publishing and least impacted by digitization and
future technology. Contributing about 1/3™ of the total publishing segment it is the largest sub-segment,
but also expected to have marginal growth of around 1% in the next 5 years. Books are now converted
to e-Books as they are released and multiple devices have enabled the digital content to be distributed
very easily. Websites like Amazon and e-Book readers like the Kindle, iPad and Surface among others,
have not only increased the reach for publishers but also enabled customers with freedom to carry
millions of pages on their devices. Apart from e-Books, another popular brainchild of digitization is
Audiobooks. Audiobooks had gained in popularity with children’s books like Harry Potter — however,
now the format is increasingly becoming popular for all fiction and non-fiction books for adults as well.

While Digitization has improved and increased distribution of books globally, the brick-&-mortar system
of books will continue to fade over the next 5 years. Many more changes like the Encyclopedia
Britannica becoming online only are likely to surface in the near future.

5. Radio

Radio is a niche segment for Media & Entertainment since it is considered to be parallel activity or mode
of entertainment for consumers. Listening to the news or music while driving or travelling without hav-
ing to carry additional content will continue to be popular. The segment is also driven by advertising
since most of all radio content is free. Avasant expects the US$45 billion segment to grow at about 3%
year-on-year for the next five years.

. Tyl
Ed

> Research > Recording > Signal Strength > Post-Release
> Idea Generation > Editing Compatibility Marketing
> Content > Quality/ Testing > Content > Advertising
Development > Noise Reduction Transformation > PublicRelations
> Selection > Voice > Broadcast > Publicity
> RJ Modification > AM > Sales Promotions
> Date & Time > Sound Analysis > FM > Direct Marketing
> Duration > Clarity Analysis > Satellite > Personal Selling
> Feasibility > Audio-Music > Cable > Low Content
> Technical Integration & > Internet Marketing
> Operational Synchronization > High Channel
> Financial Marketing
> Finalizing > TRP Ratings
Content Distribution/Marketing
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United States and countries in Western Europe are the most developed markets for radio broadcasters,
but are expected to be stagnant. Emerging economies like China, South Africa, India, Argentina,
Venezuela, Pakistan and the Philippines. Satellite Radio and paid digital radio will continue to remain
small with less than 10% of the total revenue.

6. Gaming

Gaming is a new segment for M&E vertical that is born from the combination of technology and
digitization. The revenue from Gaming can be segmented into the various revenue/distribution channels
like 1) Online, 2) Mobile, 3) Console, and 4) PC. Behind internet-based advertising, Gaming is expected
to be the fastest growing segment with close to 7% growth from its present USS65 billion market.

Processing Release - Post Release
N =
J N oo”
= - -

> Research > Planning > Distribution > Post-Release

> Treatment Animation > Global Release Marketing
> Target Customer > Designing > Regional Release > Advertising
> Age > Coding Internet > PublicRelations
> Interest > Testing {Downloadable) > Publicity
> Location > Simulation Online Gaming > Sales Promotions
> Medium Testing Packaged > Direct Marketing
> ldea Generation > Prototyping Distribution > Feedback
> Concept > Module based > For PC > Updates/Fixes
Development Testing > For Handheld > New Version/
> Concept Testing > Real Time Consoles Extended Versions
> Background Music Testing > For Consoles > Awards &
Composition > Beta Testing Felicitations
> Characterization Content
> Feasibility Encapsulation
> Technical Content
> Operational Transformation
> Financial > Consoles
> Finalizing (PlayStation,
Xbox, Wii etc.)
> PC /Mac
> Internet
Browser
> Mobile Devices
(i0S, Android,
Blackberry,
Nokia etc.)
> Tablet PC

Content Distribution/Marketing

Being a new segment, it is still more prevalent in the developed economies of North America, Western
Europe, Japan and Australia. Other developing economies like China, Russia, India, Vietham, Hungary,
Czech Republic, Poland and South Africa all have double-digit estimated growth rates for the next five
years.
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While consoles from Microsoft, Sony, Nintendo
offer gaming at its best, the most widespread
distribution channel is over the internet and
social media. Mobile gaming on the other hand is
the fastest growing market with over 12% growth
expected YoY until 2018. PC is the rapidly
becoming a redundant channel for gaming, how-
ever, it still finds some takers for the next five
years.

Another traditional segment of gaming, which has
been able to perform well are casino games and
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.

Gaming Revenue 2013 by Platform

PC
12%

Online
35%

Console
39%

Mobile
14%

machines. Casino gaming is expected to grow at over 2% in the next 5 years.

The largest segment of revenue for M&E however, provided not by the content driven verticals of

movie/cinema, television, music, publishing, radio or gaming — but by the two horizontal services, which

run across the content services.

1. Internet: which not only enables distribution of M&E content, but is the single largest impact of

digitization of content for the segment

2. Advertisement: innovative distribution of free content (the Google model), is enabled because
of networked advertising in the new digital era. It is not only the single largest source of revenue
for M&E but also promises to be the game changer for the industry

7. Internet

While the internet is responsible for highest revenues globally and majority of M&E is expected move to

the cloud in the next five years —

. . ~ R
there still remains a large untapped Global Internet Revenue 2008-18
segment. Internet  broadband

. &=Nobile Internet ®&—=Broadband Internet
penetration globally has only
reached about 40% and mobile 65%
. . . c o 62% 59% 0 5gy 60%
internet penetration is only 25%. o o 55% 53% .o, s2% 54% 57% o o
. . . o @
This scope of future expansion is ® -9 *—35 o ¢
® ®

the key reason why Avasant ex- 4 . o o

y Y ° ° 45% 47% 50% g3 46% [ ]

pects around 11% growth for the 350, 38%

M&E services across the internet in
the next five years.

41%

43%  42%

40%

Challenge of multiple platforms

L 2008 2009 2010 2011 2012 2013 2014 2015 2016 2017 2018

comes from the customers who no

longer wants to purchase content outright. Streaming online and OTT (Over-The-Top) services are gain-
ing ground rapidly. The content available for purchase outright is expected to be portable across the de-
vices that the consumer may already have — this throws out additional challenges to the content pro-
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ducers. Its not just needs to work with multiple devices but also devices running on multiple platforms
and screen resolution.

Additionally, with the explosion in smartphone sales and rapid access to mobile internet, the landscape
for internet services is also under transformation. Content is now demanded not only for PCs and
laptops but also for mobile devices. New set of devices/technology like smart TV with browsing feature,
gaming consoles with full browsing capability and tablet PCs with ability to connect using 3G/LTE or
broadband increase the challenge for content developers. With 50-50 split between mobile and
broadband, the content is presently under transition. Most portals are creating intelligent pages that
identify the device used and adapts accordingly. By 2018, when mobile internet would become the
primary distribution channel for the sector, content standardization across platforms can be expected to
answer the challenges currently faced.

United States, United Kingdom, Japan and China have the largest revenue per user for broadband
services and are expected to have double-digit growth. Spend on internet services is shifting from
broadband to mobile and in the next five years mobile internet is expected to overshadow broadband
services. Growth in penetration will however be driven by emerging economies like BRIC and countries
in Latin America.

8. Advertising

Advertising is the single largest revenue contributor to M&E with US$475 billion in total. Advertising is
yet another M&E segment that is under transition due to technology and digitization. Avasant expects
the segment to grow at around 7% over the next five years.

From the way advertising works for television, the technology change from traditionally terrestrial
television model to paid subscriptions — the entire delivery model is under change. Free-to-air to digital
based satellite or online television has not only

~
changed the way content is produced and dis- Advertising Segment Revenue 2013

tributed but also advertising models. With intelli-
gent devices and data being absorbed from what

we consume, advertising is not only intelligent
Internet

but customized to individual consumers’ re- 34% v

37%
quirements.

Segments like outdoor advertising and other tra-

ditional medium have managed to sustain, but
Newspaper Out-of-Home

are expected to stagnate in terms of growth. In- 19% 10%

teractive advertising and connectivity has com- L
J

pletely changed the way advertising content is
now presented and delivered. B2B advertising however is the most unaffected segment and will
continue to grow at around 4% over the next five years.

The largest segment of advertising continues to be television advertising, however internet advertising is
rapidly catching up to television. While television advertising revenues will continue to be more than
internet, it is expected to surpass all other formats of advertising by 2020. Presently, internet
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advertising garnered USS$160 billion in 2013. As online retail increases further, advertising over the
internet is expected to grow at over 12% year-on-year in the next five years.

Conclusion

Media & Entertainment organizations are facing challenges in face of digitization and technology, these
waves are changing the way content is created, distributed and consumed. Delivery models are
changing from free-to-air, to subscription based and consumer drives the content demand. The industry
is in a transformation phase with the change from analog to digital. Newspapers, books and magazines
are sold in both digital and printed formats and music is heard both in audio CDs and iPhones.

With mobile internet becoming the primary internet source and digital becoming the default format for
M&E content — future of the industry belongs to technology and innovation. New devices, technology
advancement in content generation and ease of distribution with higher internet penetration will drive
M&E. The impact of new wave technology innovations, including social media, mobility, analytics and
cloud (SMAC) is expected to create differentiation between M&E organizations.

Animation, gaming and visual effects are the new kids on the block with maximum potential and pene-
tration for outsourcing. While talent for creative arts remains low, developing countries like China, India
and The Philippines’ talent pool has been effective in normalizing the impact for production houses.
Internet and advertising, the two horizontal segments for M&E have been able to drive the six content
driven verticals and its supply. Demand, on the other hand has shifted into the hands of the customer,
with complete flexibility of devices, platforms, content type and interaction. The same game is available
over social media, mobile phone, personal computer or on a gaming console based on what device the
customer uses.

For Media & Entertainment companies, it is exciting times and interesting to witness the catalysts of
technology and innovation — changing the M&E landscape. Avasant views competitive advantage in
being able to collaborate and seamlessly integrate content to meet consumer demand.

Avasant assists its Media & Entertainment sector clients to secure a position of strength with the new
digital supply chain via:

1. Sourcing of IT applications & infrastructure services with the focus on building a competi-
tive digital advantage

2. Driving cost take out in the back office via business process outsourcing initiatives in
metadata, HR and F&A.

3. Securing the leading outsourcing relationships in the area of network engineering and new
product development for broadcast clients

4. Setting up captives to capitalize on local talent during a geographic expansion in Europe,
LATAM, Middle East, Africa and Asia

5. Software and IP License Optimization across the enterprise

6. Cost Management for tribal, commercial casino enterprises with a special focus on licensing

regimes for technology providers.
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With its global headquarters in Los Angeles, California,
Avasant is a leading management consulting, research, and
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private, and non-profit sectors. Our talented team of
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and Globalization Consulting.
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